
How to use the Exerciser Revision Tool (v356)  
This document tells you how to use the Exerciser revision tool either as a drawing tool or as a 
revision tool. It begins with a summary of how to install and run the tool (more details, if 
required, can be found in the READ ME document downloaded with the tool). 

 

Pre-requisites 
The Exerciser revision tool should run on any computer with a Java Runtime Environment (JRE) 
installed on it (it has been tested with Sun’s JRE). Go to the Java website www.java.com to 
obtain a copy of JRE. 

 

Installing the Exerciser 
The Exerciser revision tool can be obtained from our website 
http://mcs.open.ac.uk/Diagrams/html/download.html  
Installing on a Windows PC 
Go to this website, and click on the link Download Exerciser for Windows PC.  
This will download a zip file containing an installer for the Exerciser Revision Tool. Unzip the 
file to obtain Exerciser.msi (a Windows installer file). Double-click on Exerciser356.msi to 
run Windows Installer and follow the on-screen instructions to save the Exerciser and its data 
files in a folder of your own choice. 
Installing on a Macintosh or Linux machine 
Go to this website, and click on the link Download Exerciser for Mac/Linux.  
This will download a zip file containing the application, ERDrawingExerciserV356.jar, a 
folder named QuestionSets (containing the questions used by the tool) and various items of 
documentation. Unzip the zip file into a folder of your own choice. 

 
The zip file for Macintosh/Linux machines can also be used for Windows machines. However, 
the installer for Windows machines provides additional support such as the provision of shortcuts 
and access to the application via the start menu. 

 

Launching the Exerciser 
Open the folder in which you installed the Exerciser where you will find the file: 

ERDrawingExerciserV356.jar 

and a folder named Questions containing some data files. There is also a READ ME file. 

Double-click on the .jar file to launch the tool: 
 

 
 

 
 

 

http://www.java.com
http://mcs.open.ac.uk/Diagrams/html/download.html
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Figure 1 The Exerciser Revision Tool when launched 
The tool is pre-configured to be used initially as a drawing tool. The full functionality of the 
Exerciser revision tool can be obtained by selecting the Revision item from the pull-down menu 
on the right-hand side of the tool bar. You will be able to draw diagrams in both modes. 

How to draw a diagram in the Exerciser 
Diagrams are drawn in the Drawing pane (see Figure 1).  
A diagram consists of a collection of boxes and links. 

Drawing boxes and links 
To add a new box or link to a diagram, the Box or Link button must be pressed (see Figure 1). 
A box can be drawn with the mouse either by clicking at the required place in the drawing pane 
to obtain a box of a standard size or by pressing the mouse cursor at the required place on the 
diagram and dragging to give a box of the required size. Once the mouse is released, a Box 
Properties window will pop up to enable a name and, if required, a description, to be given to 
the box. 

To add a new link between two boxes on the diagram, press the Link button, press inside one of 
the boxes and drag to the second box. Once the mouse is released, a Link Properties window 
will pop up enabling various attributes to be added to the link. Link attributes include: 

 a name (and a description when the small arrow button has been pressed); 

 a crowsfoot at each end of the link; 

 a blob, which can be open or closed, at each end of the link. 

Click here to 
obtain the full 
functionality 
of the tool 

Box Button to 
draw boxes 

Editing buttons Link Button 
to draw links 

Select 
drawing 
elements 
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A self-link, that is, a link between a box and itself (also known as a recursive link), is drawn by 
first pressing the Link button and then either clicking inside the box or pressing inside the box 
and drawing a short line within the same box. Once the mouse is released a Self Link 
Properties window will pop up, which is similar to the Link Properties window but also has a 
drop down menu to enable you to choose the corner of the box at which the self link will be 
drawn. 

Selecting and moving boxes and links (individually or in groups) 
Individual boxes and links can be selected by first pressing the Select button and then clicking 
on the box or link. Whenever the cursor is over a link, it changes to a hand-icon.  

Multiple boxes and links can be selected by first pressing the Select button and then pressing the 
mouse outside the area to be selected and dragging to create a rectangle with a dashed border to 
surround the elements to be selected. 
Once selected, a box will have 8 small square edit points which can be used to re-size the box. 
Press the mouse on an edit point and drag the point to re-size the box. A box can be moved by 
first pressing the Select button, then pressing the left-hand mouse button inside the box (the 
cursor will appear as a cross of arrows) and finally dragging the box to a new location. 
The middle of a link can be moved (re-positioned) by first selecting the link and then dragging its 
middle edit point to the new location. An existing link can be made to link to another box by first 
selecting it and then dragging one of its end edit points to the other box. 

The name of the link can be moved independently to a new location by clicking on the link and 
then pressing on the name and dragging it to a new location. Note: if the link is subsequently 
moved, the name will normally not be moved. If a name becomes too far removed from its link, it 
can be difficult to identify which link the name belongs to. Therefore, when a link is selected its 
name is highlighted by having a rectangle drawn around it.  
You can change the properties of a box or a link at any time by selecting the box or link and then 
right-clicking on the box or link. 

Saving and retrieving a drawing 
Whenever you draw an ERD you can save it in a file on your PC (use the tool’s File menu and 
choose Save As) – this will create a file with extension .xml. You can open a diagram file that 
you have previously saved with the tool by choosing Open Drawing from the tool’s File menu. 

There are other editing facilities, the details of which can be found by clicking on the tool’s Help 
menu. 

Copy and Paste 
It is possible to copy a (selection of) a diagram and paste the copy either within the same diagram 
or to a Word document. To copy a drawing to a Word document, go to the tool’s Edit menu, and 
choose Select All. Then, from the Edit menu, choose Copy (or use the Copy button on the 
tool bar). You can now position the cursor in the Word document at the place where you want to 
insert the drawing and paste it into the Word document. 

Undo 
The last editing action can be undone by pressing the Undo button. 

Formatting a diagram to look ‘pretty’ 
There is a variety of mechanisms for formatting/structuring a diagram: drag a box or the mid-
point of a link, or use the Edit menu items ‘Straighten link’ (to straighten a link whose mid point 
has been moved) and ‘Rectilinear Link’ (to make link run horizontally and vertically). 
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How to use the Exerciser Tool 
The ER diagram Exerciser enables you to practice drawing entity-relationship diagrams.  

Change to revision mode by selecting the Revision item from the pull-down menu on the right-
hand side of the tool bar (see Figure 2).  

 

 

 
 

 
 

Figure 2 The Tool in Revision mode 
 

In Revision mode, start by choosing a question to answer; that is, click on the Question button 
on the tool bar (see Figure 2). The Exerciser contains several sets of questions and you choose 
one by first selecting the question set (either Relational or Scenario) and then the number of the 
question and clicking OK (see Figure 3). 

 

 
Figure 3 Selecting a question 

The tool remembers which questions you have already attempted, so you can stop at any time and 
resume from that point at a later time. The question appears in the left-hand Question panel of 
the main screen (see Figure 4).  
You draw your attempt at answering the question in the top right-hand Diagram panel. 
Instructions for drawing diagrams are given above. 
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Figure 4 The question displayed in the tool 
Once you have drawn a diagram you can ask the system to mark it by clicking on the button 
labelled Mark (see Figure 5).  
 

 

 

 
 

 
 

 
 

Figure 5 A drawing is constructed 
The system responds by displaying a small window in which the system reports how well it 
thinks your answer corresponds to the specimen solution by awarding a grade (a mark) as shown 
in Figure 6.  
 
 
 
 

 
 

 
      Figure 6 The system generated mark 

Mark the 
drawing 
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The system asks you whether you want further details (see Figure 6). If you do, the system will 
provide an additional window that indicates where your diagram matches the solution diagram. 
The first level of detail is illustrated in Figure 7 where the answer diagram is shown with various 
elements drawn with short dashed lines and a blob shaded. 
 

 
 

 
 

 
 

 
 

 
Figure 7 The feedback window 
In Figure 7, boxes and links drawn with solid lines indicate those that the system thinks are 
correct. Dotted boxes and links and shaded blobs are thought to be incorrect in some way (this 
can be minor errors in naming a box, incorrect blobs and crowsfeet on a link, and boxes which 
should not appear on your diagram – an explanation of how to interpret the information on the 
feedback window can be obtained by pressing the Key button). 
The feedback window (Figure 7) has a button labelled Marker Report which, when clicked, 
reveals a small text window containing a report from the automatic marker on a range of issues 
that it has found during the marking process (see Figure 8). 

 
 

 
 

 
 

 
 

 
Figure 8 Additional feedback from the feedback window 
At any stage you can view the specimen solution by clicking on the button labelled Show / Hide 
(see Figure 9). The solution will appear in the bottom right-hand Solution Diagram window as 
shown in Figure 9. 
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Figure 9 The solution revealed 
Additional help is available in the form of explanations of how the specimen solution was arrived 
at. When you left-click on any of the components in the solution diagram, the relevant part(s) of 
the question that relate to that component will be highlighted as shown in Figure 10. 

  
 

 
 

 
 

 
 

 
 

 
 

 
 

Figure 10 Left click on solution component to see its relationship with the question 
Right-clicking on a component will cause a properties window to appear containing an 
explanation of the derivation of that component (see Figure 11). 
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      Figure 11 The properties of a link 
 

Pressing the Read button (on the link properties window) provides a reading of the meaning of a 
link. A link can be read in either direction so there are two readings: see Figure 12 for an 
example. 
 

 
 

 
        Figure 12 The readings of a link 

Keyboard shortcuts 
There are numerous keyboard shortcuts. A full list can be obtained by clicking on the Help 
menu. However, a useful shortcut is using the right mouse button. Right-click on a box or link 
will reveal a small pop-up menu providing quick access to common actions. Right-click on a 
blank area of the drawing window will reveal another small pop-up menu providing quick access 
to more common global editing facilities. 

Obtaining Help 
To obtain help, click on the Help menu. This will provide access to a variety of types of help 
including: how to draw diagrams, how to use the exerciser in revision mode, keyboard shortcuts 
and tips on how to perform some of the basic editing actions. There is also a searchable index of 
all terms associated with the Exerciser. 

Assistance requested 
Whenever you use the Exerciser, it records brief details of whatever you do in a text file named 
Report.txt (saved in the application folder). We would appreciate it if, once you have finished 
your revision, you would email this file to us at mcs-diagrams@open.ac.uk for analysis to enable 
us to develop an understanding of problems that students encounter and hence to improve both 
the tool and the course. There is also a questionnaire (very brief) that we would appreciate 
receiving. You can find it in the same folder that the Exerciser is stored in. 

mailto:mcs-diagrams@open.ac.uk

